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StageConsole User Manual 

Version 1.6.0  

StageConsole  - a simple 2-scene preset light board with cue memory and timed 
crossfades. It supports any number of lighting control channels up to 512. 

It sends DMX lighting control protocol data to the Enttec DMX USB devices and ArtNet.  

USB Drivers for the correct interface from Enttec.com must have been installed. 

The user-interface has several windows: 

 Console (faders)  
 Run 
 CueList 
 Submasters 
 Output Monitor  
 Command Line  
 Soft Patch  

I wrote this software in Visual Basic 6.0 and am releasing it to the public domain. 

I intend to post updates periodically at: http://www.chromakinetics.com/DMX/ 

Comments/Suggestions/Improvements/Bug reports/etc. are welcome:  
Glenn Meader dmx@chromakinetics.com 
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Console window 

This window has the fader controls for the 2 scenes.. It is laid out like a traditional 2-
scene preset manual board. The upper row of sliders sets the levels for Scene A and 
the lower row of sliders set the levels for Scene B. The Crossfader slider (on the Run 
Window) controls the output mix of levels between Scene A and Scene B.  

The blue boxes are channel labels. Whatever you enter in the blue boxes is saved with 
the show.  

The yellow boxes show the current slider settings in percentage. (all levels are internally 
calculated and output to DMX from 0 to 255, but are displayed in percentages). The 
active scene boxes are yellow, the inactive scene level boxes are white.  
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Below each slider is a "Bump" button. Click it with the left mouse button and the slider 
will go to 100% while you hold the mouse button. Use the right mouse button to toggle 
the slider from 0% to 100% and back.  

The menu File item allows you to save and load stored shows. A show is an ordered list 
of cues. You must use this menu to save changes to cues for a show. The name of the 
last show you worked on is stored and that show is loaded when you run the program 
again. 

The Cue menu allows you to delete a cue from the list, and display the cuelist window.  

The Window menu allows you to get any window displayed. The Arrange All menu item 
displays all windows on screen in a default arrangement. 
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Settings menu 

The Settings menu allows you to set various configuration 
parameters. Settings are saved with each show.  

Name of Show sets the title.  

Soft Patch allows you to assign DMX channels to faders.  

Number of Channels/faders. You may enter as many 
channels as you want, up to 512, but performance may 
degrade with large numbers of channels. The fader window can only be as wide as your 
display, so that limits the number of faders that can be displayed at once. If there are 
more channels than can be viewed in the window, a scrollbar appears at the bottom so 
you can access all the faders. 

Device allows you to choose your DMX interface device and set any parameters for it. 
Device dialog  

MIDI is not implemented yet. It will allow you to assign MIDI controller commands to 
faders, masters and buttons. 

 

SoftPatch window 

This window allows you to assign DMX channels to faders. 
Press F6 to view this window.  

The automatic default patch is 1:1 

A fader may have any number of DMX channels assigned to 
it, but a DMX channel may be assigned to only one fader.  

To assign a DMX channel to a fader, simply enter the fader 
number in the column to the right of the DMX channel. 

You can save and load patches to disk using the File menu 
Save and Open items. 

The Print Menu will print a report on your default printer.  
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Devices dialog  

Select which device you are using and/or enable Artnet.  

Enttec USB DMX devices are supported. Info is at 
www.enttec.com  

ArtNet is a way of sending DMX information over IP 
networks. ArtNet was created by Artistic Licence  

 

 

 

Run Window 

This window contains the controls for running a show.  

The Go button moves the crossfader from one 
scene to the other at the Fade Time rate 
(seconds). The Cut button instantly moves the 
crossfader to the other scene. The Back button 
"cuts" back to the previous scene.  

Keyboard shortcuts are: Ctrl-G=Go, Ctrl-B=Back, 
Ctrl-C = Cut, Ctrl-O=Blackout .  

TheScene A and Scene B buttons allow you to 
load a stored cue's levels into the sliders for that 
scene. The stored fade time is also loaded. Next to 
these buttons the Cue Number is displayed. Below 
the scene number is the Cue Title. You click on the 
title to enter text there. The Save buttons allow you 
to save the levels, Fade Time and Cue Title as a 
numbered cue. Cue numbers are decimals so you 
can store fractional cues (e.g. cue 21, 21.5, and 
cue 22)  

The Grand Master controls the final DMX output levels for the entire console. The 
Blackout button toggles setting all outputs to 0% and restoring the levels to whatever 
they are set to by the other controls. 
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CueList Window 

This window shows the stored cues, sorted by cue number. You may skip cue numbers. 
(there is no cue 5 in the figure at right) You may use decimal cue numbers to insert 
between two whole number cues. Delete a cue by using the delete Cue menu item.  

The cue number, fade time, cue title and the levels are displayed on each row. The 
pending cue (cue last loaded into a scene/crossfader) is highlighted in light blue.  

 

You may edit any value by clicking on the cell you want to change (it will turn yellow) 
and enter new info in the yellow textbox just above the column titles. Move between 
cells with left and right-arrow keys and/or the Enter key  

You may select a cue by clicking its cue number with the mouse. You may then load it 
into a scene's faders by clicking the Scene A or Scene B buttons on the Run Console 
window. 

or 

If you double-click on a cue, it will be loaded into the inactive scene (the scene the 
crossfader is away from)  
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To copy a cue, load it into a scene and then save it with a new or different cue number.  

the SaveCue menu item stores the current look (whatever is live onstage, including 
levels from faders, Grand Master and submasters) in a cue.  

The Print menu item prints this list on the default printer. 
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Submaster window 

This window allows you to assign cues to submaster faders. Press F6 to view this 
window, or select it from the Window menu. 

Right-click on the blue Scene# field above a submaster fader to assign a cue number to 
the submaster. You may assign any valid cue number (Cue numbers are listed in the 
first column in the Cue Listing window).  

The submaster faders "pile-on" the levels stored in the associated cue. This means the 
levels of the submaster's cue are added to the current levels from the channel faders 
and the crossfader in a HTP (Highest Takes Precedence) manner. 

Independent 
If you check the Independent checkbox for a submaster, it will override any levels, 
including the grand master. However, any channels stored with a zero level will not be 
overridden. This means that you must have stored a level of at least one into any 
channel in the cue you want to control with an Independent submaster.  

LTP The LTP checkbox is not implemented yet.  
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The Config menu allows you to set the number of submasters. The maximum number 
of submasters is 256. The minimum is 8. The figure below shows 16 submasters. Fewer 
submasters gives better performance. 

The notebook tabs allow you to access "pages" of submasters, if there are more than 
will fit in the window.  

 

Output Window  

This window displays the current output levels being sent out via DMX. This window 
resizes itself to show the number of channels you have configured your settings for 
(Settings Menu).  

 

 

DMX Error message 

 

If your DMX hardware is not working or attached, you will receive this message when 
the program starts up. You can still use the program normally, but no DMX output will 
be sent.  
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Command line window 

This window allows you to set channel and 
submaster levels by typing commands. You can 
click the on-screen buttons, or type on your 
keyboard. 

The current command being entered is shown 
on the tan colored line. The just previously 
executed command is shown on the black line 
above. 

Selecting "Live scene" (the L command) means 
levels will be set on the active scene (A or B), 
live onstage. Selecting "Blind scene" (the B 
command) means levels will be set on the 
inactive scene. Cues always load into the Blind 
scene, unless you preceed the cue command 
with the L command (even if "Live scene"is 
already selected).  

You can load and execute ( "Go") cues and set the fade time speed. You can record 
scenes.  

View the complete syntax for the commands by pressing the help button. 
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Command Line Syntax  

The key syntax is designed so that you can use either a PC numeric keypad or a 
standard keyboard without having to use the shift key. Levels are 0 to 100. Commands 
are similar to ETC Express console commands.  

To set levels, type in a channel number, the @ sign and a number for the level, then 
press the Enter key to set the level. The table below shows how to select multiple 
channels instead of just a single channel. 

The [Enter] key executes the command. The Backspace key deletes characters.  

 

Keys to select channels:  

channel  0 1 2 3 4 5 6 7 8 9  

AND  P or p or + ( plus sign)  

THRU  T or t or / ( slash or division symbol)  

EXCEPT E or e or - (hyphen or minus symbol)  

MASTER M or m (must be followed by a number)  

BLIND B or b  levels are set in the inactive scene 

LIVE L or l  levels are set in the active scene  

Enter digits for channel numbers. To select multiple channels, you can use the AND, 
THRU and EXCEPT keys as well.  See examples below. 

Prefixing a number with an M designates a submaster, instead of a channel. Master 0 is 
the grand master, any other master number designates a submaster.  
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Keys to set levels:  

level  0 1 2 3 4 5 6 7 8 9 

AT  A or a or @ or * (asterisk or multiply sign) 

FULL  F or f or [Enter] without a level number 

If you enter a single digit for the level, it will be interpreted as ten times that number. For 
example if you enter just a 4 for the level, the level will be set at 40%. To set levels 
below 10% you must enter a zero before the digit. For example to set a level of 5%, 
enter 05 as the level.  

If you do not enter any channel numbers -- just entering: @ level, the previously 
selected channels will be set. 

Example Commands  

To select channel 34 and set it to 25%, enter: 

34@25  [Enter] 

Use [AND] to select channel 10 and 20 and set them to 50%, enter: 

10+20@5 

Use [THRU] to select a group of consecutively numbered channels, 3 thru 9 and set 
them to full, enter: (no level value is given after the @ symbol) 

3/9@   sets channels 3,4,5,6,7,8, and 9 to 100% 

Use both [THRU] and [AND] to select channels to include in a selection. 

1-5+8+11@75   sets channels 1, 2, 3, 4, 5, 8 and 11 to 75% 

Use [EXCEPT] to exclude each non-consecutive channel from a selection.  

1/5-2-4@6   sets channels 1, 3, and 5 to 60% 

To exclude consecutive channels from a selected group of channels, press [Except] 
before entering the channels to exclude. To select channel 1 thru 10 except channels 4 
thru 6 and set them to 30%, enter: 
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1/7-4/6@3   sets channels 1, 2, 3, and 7 to 30%  

Levels are set to the active, Live scene by default. Give the BLIND command to switch 
to BLIND mode, allowing levels to be set in the inactive, Blind scene. 

B - Switch to Blind mode, commands affect the inactive scene  

L   - Switch to Live mode, commands (except Cue) affect active scene.  

Cue commands  

Keys to activate cues:  

Cue  C or c (must be followed by a cue number)  

Go G or g  

Speed S or s (followed by a decimal number of fade time seconds)  

Live L or l - load the cue into the live, active scene.  

Record R or r (must be followed by a cue number)  

Blind B or b - set Blind mode: all further commands affect the inactive scene.  

Examples:  

C32  Load cue number 32. Loads the cue into the inactive scene. You must follow the 
C command with a cue number. 

C12g  Loads cue 12 into the inactive scene and then crossfades to it at the speed 
stored with the cue.  

LC45  Load cue into to the LIVE, active scene. Cue 45 will immediately appear, live 
with no fading. Cues always load into the Blind scene, unless immediately preceded by 
an L command.  

S3.5   Set the fade time speed to 3.5 seconds. You must the S command with a 
number of seconds which may include a decimal to indicate tenths of a second.  

R5  Record the current scene as Cue number 5. The current scene is either Live or 
Blind: whatever mode you are currently in. You may precede the R command with a B 
or L to specifically set the Live/Blind mode.  


